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Introduction

This Tutorial will use the OPC UA protocol to send data
between different devices or different programs.

OPC UA is a communication protocol.

OPC UA is mainly used for industrial purposes (industrial
automation), and it is one of the most used protocols in the
industry today.

OPC UA is maintained by: https://opcfoundation.org.

Python is a widely used multi-purpose Programming

language and one of the most used programming languages
today.

Python is maintained by: https://www.python.org.



https://opcfoundation.org/
https://www.python.org/

OPC UA Example

We will create different OPC UA Clients and an OPC UA Server in this Tutorial
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Introduction

There exists lots of different OPC packages and libraries for Python.

This Tutorial will demonstrate OPC UA in Python with some basic
Code Examples using the “opcua” Python package.

This Tutorial will use the Thonny Python Editor and the Spyder
Python Editor, but other Python Editors can of course also be used.

This Tutorial will use the OPC UA Server Simulator from Integration
Objects (free OPC UA server for Test and Demonstration purposes),
but other OPC UA Servers can of course also be used.

We will create both OPC UA Clients and an OPC UA Server using
Python and the “opcua” Python package.



Software

The following software is used in this Tutorial:

 Thonny Python Editor
https://thonny.org

e Spyder Python Editor. You can download it separately or part of
Anaconda Python Distribution
https://www.spyder-ide.org
https://www.anaconda.com

* Python package/library opcua
https://pypi.org/project/opcua/
e (OPC UA Server Simulator:

https://integrationobjects.com/sioth-opc/sioth-opc-unified-architecture/opc-ua-server-simulator/

 UaExpert OPC UA Client:

https://www.unified-automation.com/products/development-tools/uaexpert.html



https://thonny.org/
https://www.spyder-ide.org/
https://www.anaconda.com/
https://pypi.org/project/opcua/
https://integrationobjects.com/sioth-opc/sioth-opc-unified-architecture/opc-ua-server-simulator/
https://www.unified-automation.com/products/development-tools/uaexpert.html

OPC Specifications

OPC is a standard that defines the communication of data between devices from different
manufactures. OPC requires an OPC Server that communicates with one or more OPC Clients

“Classic” OPC — “Next Generation” OPC

~ OPCDA | o
~ OPCHDA | — OPCUA
 OPCA&E |

https://opcfoundation.org/about/opc-technologies/opc-classic/



https://opcfoundation.org/about/opc-technologies/opc-classic/

Next Generation OPC

COM/DCOM ! XML, HTTP, SOAP
[ OPC Classic }H Next Generation OPC>[ OPC UA
s OPC DA ] Windows only Cross-platform All specifications
, I Windows, Linux, Mac, collected in one (DA,

Embedded, VxWorks

HDA, A&E)
Protocols: “UA Binary” or “UA XML”

Simpler!!

: OPC DA Server <:> . I
OPC HDA Server || OPCent || [opc ya Server | <~ [ OPC UA Client |

|

!

(DCOM)
OPC A&E Server <:(>




OPC UA — Server and Clients

OPC is a standard that defines the communication of data between devices from different
manufactures. OPC requires an OPC Server that communicates with one or more OPC Clients.

OPC UA Client OPC UA Server
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OPC UA Scenario

Cloud/Network
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OPC UA Scenario

Programmable Automation Controller

OPC
Server

Distributed Control System
PAC

Programmable Automation Controller SCADA

Supervisory Control And Data Acquisition



OPC UA Examples in this Tutorial

OPC UA Server In this Tutorial we will create both OPC
Clients and and an OPC Server where

[eoo ] we use the “opcua” Python package
Normally, the OPC Server w
and the different OPC — —
Clients runs on different
computers distributed in a
network

OPC UA Write Client OPC UA Read Client



Installation of “opcua” Thonny

" T& Manage

Iopcua

I

<INSTALL > A

adafruit-board-toolkit
astroid
asttokens
berypt
bitstring

cffi

colorama
contourpy
cryptography
cycler
deprecation
dill
dnspython
docutils
ecdsa
esptool
fonttools
guizero

isort

jedi
kiwisolver
lazy-object-proxy v

Search results

opcua
Pure Python OPC-UA client and server library

opcua-webclient

A OPCUA web client, implemented by Python.

opcua-widgets
OPC-UA Widgets

opcua-modeler
OPC-UA Address Space Modeler

formic-opcua
<No description>

opcua-client
OPC-UA Client GUI

opcua-tools

‘ Search on PyPI ‘

mypy Summary: Pure Python OPC-UA client and server library
Author: Olivier Roulet-Dubonnet

Homepage: http://freeopcua.github.io/

mypy-extensions
nidagmx

‘ ﬁi ackages for C:\Users\hansha\AppData\Local\Programs\Thonny\python.exe ‘
Iopcua Search on PyPI ‘
isort A
jedi Oopcua
kiwisolver
lazy-object-proxy Installed version: 0.98.13
Ixml Installed to: C:\Users\hansha\AppData\Roaming\Python\Python310\site-packages
matplotlib
mccabe Latest stable version: 0.98.13
|

RGPy PyPI page: https: i.org/project/opcua

opcua | |
packaaina |
paho-mqtt

paramiko

parso

pillow

pip

platformdirs

pycparser

pylint

pymongo

pynacl v Upgrade Uninstall Close



Installation of “opcua” Anaconda

You can use the “Anaconda Prompt” that comes with the Anaconda Distribution

B Anaconda Prompt (Anaconda3) - O X

pip install opcua

Requirement already s
)
Requirement already satisfied: python-dateutil in c:\programdatalanaconda3\lib\site-package
s (from opcua) (2.8.2)

Requirement already satisfied: 1xml in c:\programdatal\anaconda3\lib\site-packages (from opc
ua) (4.6.3)

Requirement already satisfied: pytz in c:\programdatal\anaconda3\lib\site-packages (from opc
ua) (2021.3)

Requirement already satisfied: six>=1.5 in c:\programdata\anaconda3\lib\site-packages (from
python-dateutil->opcua) (1.16.0)

(base) C:\Users\hansha>

https://www.anaconda.com/download https://pypi.org/project/opcua/



https://pypi.org/project/opcua/
https://www.anaconda.com/download

References

Dy P
yPI:
nttps://pypi.org/project/opcua/
Python OPC-UA Documentation:
nttps://python-opcua.readthedocs.io/en/latest/

GitHub:
https://github.com/FreeOpcUa/python-
opcua/tree/master/examples

GitHub Client GUI:
https://github.com/FreeOpcUa/opcua-client-gui



https://pypi.org/project/opcua/
https://python-opcua.readthedocs.io/en/latest/
https://github.com/FreeOpcUa/python-opcua/tree/master/examples
https://github.com/FreeOpcUa/python-opcua/tree/master/examples
https://github.com/FreeOpcUa/opcua-client-gui
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OPC UA Server Simulator

“OPC UA Server Simulator” from Integration Objects is
a free OPC UA Server

You can use it for Test and Demonstration purposes.
It runs 48 hours before you need to restart it
Users can configure their own OPC Tags via CSV files

Download:
https://integrationobjects.com/sioth-opc/sioth-opc-
unified-architecture/opc-ua-server-simulator/



https://integrationobjects.com/sioth-opc/sioth-opc-unified-architecture/opc-ua-server-simulator/
https://integrationobjects.com/sioth-opc/sioth-opc-unified-architecture/opc-ua-server-simulator/

OPC UA Server Simulator

B OPC UA Server Simulator —

File » Settings » Help ~

Server Endpoints URLs opc tcp://xps15hph:62640/IntegrationObjects/ServerSimulator

Sessions f

Sessionld Name User Last Contact

\

| Subscriptions }

Subscriptionld Publishing Interval ltem Count Seq No

Status: Running  Cument Time: 11:01:11  Sessions: 0 Subscripions: 0  ltems: 0




OPC UA Client

* Integration Objects also offer a free OPC UA
Client

* You can use it for Test and Demonstration
purposes
e Download:

https://integrationobjects.com/sioth-opc/sioth-opc-unified-
architecture/opc-ua-client/



https://integrationobjects.com/sioth-opc/sioth-opc-unified-architecture/opc-ua-client/
https://integrationobjects.com/sioth-opc/sioth-opc-unified-architecture/opc-ua-client/

OPC UA Client

[ | Integration Objects' OPC UA Client

Home

P e e 2O = )

Hel About Defi Remove Certificate Manager
New Open  Save & ne © i e ‘

File Session Configuration Hel - -
% Connection Settings x
Data View | Hists =
Sessions Display — Session Information P Value
Session Name |Session0 |

— Server Information

Endpoint Url Iopc.tcp://xps1Shph:62640/|ntegration0bjects/§Iz” [ Discover

— Ti port Protocol — M ge Encoding
|Addr&ss Space ® Opc.tcp @ Binary
Forward .
I ©) Https O Xml
— Security Mode ————  — Security Policy
@ None ® None
(O Basic128RSA15
<) sign .
() Basic256
® Sign’Enceypt (© Basic2565ha256
— User Authentication Mode
® Ancnymous ©)UserName ©) Certificate

Certificate (.pf) |

Password I I ‘
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UaExpert

 UaExpertis an OPC UA Client from Unified
Automation

* Homepage:
nttps://www.unified-automation.com

* Download UaExpert:

https://www.unified-automation.com/downloads/opc-ua-clients.html



https://www.unified-automation.com/
https://www.unified-automation.com/downloads/opc-ua-clients.html

UaExpert OPC UA Client

- Unified Automation UaExpert - The OPC Unified Architecture Client - NewProject™ = O >
= = o ~ r
De BB X & =
Project & X  Data Access View © Attributes & x
v~ [@ Project # Server Node Id Display Name Value Datatype source Timestamg Server Timestamp < | & (]
v a E:’VE'S 1 LabVIEW OPC U... String]... Temperature 26 01:0 G| | Attribute Value ~
2 LabVIEW OPCUAS —Dug—
o Srver 2 Python OPC UA... NS2|Numeric|2  Temperature 20 Int64 0 000 0 G| - MNodeld ns=2;s=Tag7
2 Python OPC UA Server : . Namespacelndex 2
2, OPC UA Server Simulator from | 3 OPC UA Server ... NS2|String|Tag7 Tag7 22 Double 14:39:03.638 14:39:03.639 G IdentifierType String
v [ Documents Identifier Tag_7
[ Dats Access View NeodeClass Variable
@ ) BrowseName 2, "Tag7"
[3 Data Access View-1 DisplayName “en", "Tag7"
Description Invalid Datatype: Ex
< > v Value
Address Space 5 x SourceTl'mestamp 2023-12-05 14:39:0:
SourcePicoseconds 0
“> | No Highlight v ServerTimestamp 2023-12-05 14:39:12
~ ServerPicoseconds 0
StatusCode Good (0x00000000)
< >
References F X
> o g% @ Forward - o
Reference Target DisplayName
HasTypeDefiniti... BaseDataVariableType
v i< >
Log F X
8 B
Timestamp Source Server Message =
2023-12-05 14:3... DA Plugin QascDaModel::dropMimeData
2023-12-05 14:3... DA Plugin OPC UA Server ... No subscription available for Serverld 2
2023-12-05 14:3... DA Plugin OPC UA Server ... Creating new subscription: ClientHandle=3, PublishingEnable=1, LifeTimeCount=2400, MaxKeepAliveCount=10, Priority=0, Publishinglnterval=500, MaxNotificationsPerPublish=0
2023-12-05 14:3... DA Plugin OPC UA Server ... CreateSubscription succeeded [ret = Good]
2023-12-05 14:3... DA Plugin OPC UA Server ... Revised values: LifeTimeCount=2400, MaxKeepAliveCount=10, Priority=0, Publishinglnterval=500, Subscriptionld=3
2023-12-05 14: DA Plugin OPC UA Server ... Created subscription for Serverld 2
2023-12-05 14: DA Plugin OPC UA Server ... ltem [NS2|String|Tag7]: Samplinglnterval=250, QueueSize=1, DiscardOldest=1, ClientHandle=7
2023-12-05 14: DA Plugin OPC UA Server ... CreateMonitoredltems succeeded [ret = Good]
2023-12-05 14: DA Plugin OPC UA Server ... Item [NS2|String|Tag7] succeeded : RevisedSamplingInterval=250, RevisedQueueSize=1, Monitoredltemld=3 [ret = Good]
v

2023-12-05 14:

Attribute Plugin

OPC UA Server ... Read attributes of node 'NS2|String|Tag7' succeeded [ret = Good].
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Python OPC UA Client Examples

* We start with creating OPC UA Clients with
Python

e Typically, most of the times we need to create
OPC UA clients, while we use existing OPC UA
Servers from different vendors that already exists
In our system

 Here, we will use the “OPC UA Server Simulator”

from Integration Objects for Testing our OPC UA
Python examples



Python OPC UA Client Examples

OPC UA Server
XN

Normally, the OPC Server X OPCUA Server Simulator”
and the different OPC w from Integration Objects
Clients runs on different —  —

computers distributed in a
network

Python Script Python Script
e S e S

OPC UA Write Client OPC UA Read Client



OPC UA Client Write

from opcua import Client

url = "xxx"
nodeId = "xxx"
client = Client (url)

client.connect ()
node = client.get node (nodeld)
value = float (20)

node.set_data_value(value)

client.disconnect ()



OPC UA Client Read

from opcua import Client

url = "xxx"
nodeId = "xxx"
client = Client (url)

client.connect ()
node = client.get node (nodeld)
value = node.get value ()

print (value)

client.disconnect ()



Python OPC UA Client Examples

§ OPC UA Server Simulator - X
File ~ Settings v Help ~
Server Endpoints URLs opc.tcp://xps15hph:62640/IntegrationObjects/ServerSimulator E|
[ Sessions |
Sessionld Name User Last Contact
T& Thonny - C: y y OPC\ )_client_write_ex.py @ 11:17 - o X L] Th Thonny - CAL OneDs ython! de B les\OPC\ops Objects _client_read_ex.py @ 10:31 - o X
File Edit View Run Tools Help File Edit View Run Tools Help
DSH 0% o™= " DSH O% o™
opcua_client_write_expy *  opcua_client_read_ex.py opcua_client write_ex.py - opcua_client_read_ex.py
1 from opcua import Client 1 from opcua import Client
2 2
3 #OPC UA Serve Simulatc frc I cegratlc j,ri,,, 3 #OPC UA Se S Simulato . integration UDJecCTs
4 url = "opc.tcp://localhost:62640/IntegrationObjects/ServerSimulator/" 4 url = "opc.tcp://localhost:62640/IntegrationObjects/ServerSimulator/"
5 nodeld = "ns=2;s=Tag7" ko 5 nodeIld = "ns=2;s=Tag7"
6 — 6
7 client = Client(url) 7 client = Client(url)
2 client.connect() 2 client.connect()
9 9
10 node = client.get_node(nodeld) 19 node = client.get_node(nodeld)
11 value = float(22) 11 value = node.get_value()
12 node.set_data_value(value) 12 print(value)
[ Write Data to OPC UA Server - Read Data from OPC UA Server
14 client.disconnect() 14 client.disconnect()
Shell Shell
>>> Run client e e >>> %R e ead_e
>>> 22.0
>>>
Local Python 3 = Thonny's Python Local Python 3 - Thonny's Python




OPC UA Client Write Example

from opcua import Client

#OPC UA Server Simulator from Integration Objects

url = "opc.tcp://localhost:62640/IntegrationObjects/ServerSimulator/"
nodeId = "ns=2;s=Tag/"
client = Client (url)

client.connect ()
node = client.get node (nodeld)

value = float (20)
node.set_data_value(value)

client.disconnect ()



OPC UA Client Read Example

from opcua import Client

#OPC UA Server Simulator from Integration Objects

url = "opc.tcp://localhost:62640/IntegrationObjects/ServerSimulator/"
nodeId = "ns=2;s=Tag7"
client = Client (url)

client.connect ()
node = client.get node (nodeld)
value = node.get value ()

print (value)

client.disconnect ()



Improvements

We improve the basic Write and Read Examples
 Adding While Loop, etc.
* Error Handling

e Getting Data from a real Sensor, e.g., a
Temperature Sensor

— | will create a “Simulator” that simulates a real

Temperature Sensor using the Random Generator in
Python



from opcua import Client

import time [ OPC UA Client Write Example }

import random

#OPC UA Server Simulator from Integration Objects

url = "opc.tcp://localhost:62640/IntegrationObjects/ServerSimulator/"
nodeId = "ns=2;s=Tag7"
client = Client (url)

client.connect ()
print ("OPC UA Client Connected")
print ("Press Ctrl-C to Stop Program")

try:
while True:
value = random.randint (20, 30)
print (value)

node = client.get node (nodeld)
value = float (value)
node.set data value (value)

time.sleep(10)

except KeyboardInterrupt:
pass

client.disconnect ()
print ("OPC UA Client Disconnected and Progam Stopped")



from opcua import Client
import time

[ OPC UA Client Read Example }

#OPC UA Server Simulator from Integration Objects

url = "opc.tcp://localhost:62640/IntegrationObjects/ServerSimulator/"
nodeId = "ns=2;s=Tag7"
client = Client (url)

client.connect ()
print ("OPC UA Client Connected")
print ("Press Ctrl-C to Stop Program")

try:
while True:
node = client.get node (nodeld)
value = node.get value()
print (value)
time.sleep (10)

except KeyboardInterrupt:
pass

client.disconnect ()
print ("OPC UA Client Disconnected and Progam Stopped")



i

File » Settings ~ Help ~

Pure Python Client.. Anonymous

Thonny Python Editor

Pure Python Client.. Anonymous

ns=3;i=896433817
ns=3;i=896433( &

i Thonny - C:\Users\hansha\OneDrive\Documents\Python\Python P: ing\Code Examples\OPC\opc Obje . = ] X
ile Edit View Run Tools Help

1= O o™

opcua_client_write_while_loop.py

import random

url = "opc.tcp://localhost:62640/IntegrationObjects/
nodeId = "ns=2;s=Tag7"

client = Client(url)

client.connect()

print("OPC UA Client Connected")
print("Press Ctrl-C to Stop Program")

try:
while True:
value = random.randint(20,30)
print(value)

node = client.get_node(nodeId)
value = float(value)
node.set_data_value(value)

time.sleep(10) .
OPC UA Client Write Example

v

Local Python 3 « Thonny's Python

Server Endpoints URLs opc tcp://xps15hph:62640/IntegrationObjects/ServerSimulator [+] ‘
| Sessions .
Sessionld Name User Last Contact S pyd e r Pyt h O n E d |t0 r

10:40:05 |

File Edit Search Source Run Debug Consoles Projects Tools View Help

. [~ a |_B | 2 (o [ I, 1 = v ) ] E:l ss+  jects Examples

...hon Programming\Code Examples\OPC\opcua\Integration Objects Examples\opcua_client_read_while_loop.py S |[Gaens Object P a

opcua_client_read_while_loop.py X

opcua import Client Usage
import time

Here you can get help of any
object by pressing Ctri+lin
front of it, either on the Editor
or the Console.

#0PC UA - mulator c
url = //localhost: / / verSimulator/"
nodeId = "ns
client = Client(url) Help can also be shown
client.connect() automatically after wrifing a
print("0OPC UA Client Connected") |E;TD$EYY|W!€SI5";X1R:3€1
p t("Press Ctrl-C to Stop Program" object. You can activate this
RERLRTeES " © P PR behavior in Preferences >
try: Help.
True:

node = client.get_node(nodeId)

value = node.get_value()

print(value)

time.sleep(10)

New fo Spyder? Read our
oy

cept KeyboardInterrupt: Help Variable Explorer Plots Files

client.disconnect() =

printl{"0oPC UA Client Disconnected and Progam Stopped"|)

Console 1/A x

°C/opcua/Integration Objects
d_while_loop. p)

4 neDrive/Document

/Python Programming/Code Example.

OPC/opcua/Integration Obje Exampl

OPC UA Client Connected

Press Ctrl-C to Stop Program

OPC UA Client Read Example

IPython console History

4 Kite: ready < LSP Python: ready @ conda: base (Python 3.9.7) Line 24, Col 55 ASCII CRLF RW Mem 45%



Running Multiple instances of the
Command Prompt

Open the Command Prompt from the Start menu

Search Apps Documents Web More ¥

Best match

Command Prompt
System

Apps

~1 Command Shell
Anaconda Prompt (Anaconda3)
summarize_model.cmd
setupVirtEnv.cmd

Microsoft SQL Server Migration
Assistant for Access Command

Search the web

D cmd.exe

£ cmd prompt
£ cmd commands
AL cmd run as administrator

,O cmder

To see work results, please verify your

account.

Command Prompt

System

Verify your account >

Open

Run as administrator
Open file location
Pin to Start

Pin to taskbar

You can also do it from the Thonny Editor:

T& Thonny - C:\Temp\Python\opcua_write.py @ 29:1

File Edit View Run Tools Help
NE (5] Configure interpreter...
opcua_write.py © Run current script F5
Debug current script (nicer) Ctrl+F5
f Debug current script (faster) Shift+F5
- 1l Visualize current script at Python Tutor
> ilh Debug current script (birdseye) Ctrl+Shift+B
/] Step over F6
» Step into F7
- Step out
Resume F8
_ Run to cursor Ctrl+F8
ni Step back Ctrl+B
Run current script in terminal Ctrl+T -
C!  Dock user windows
C Pygame Zero mode
p @ Stop/Restart backend Ctrl+F2
Interrupt execution Ctrl+C
LZ P! sendEOF/ Soft reboot Ctrl+D
Disconnect

try:
while True:

:62640/IntegrationC

cted")
p Program")



Mic
(c)

3

File » Settings ~ Help ~

Server Endpoints URLs opc tcp://xps15hph:62640/IntegrationObjects/ServerSimulator
Sessions
Sessionld Name User Last Contact
Pure Python Client.. Anonymous 14:48:48
Pure Python Client.. Anonymous 14:48:45

Subscriptions

Subscriptionld

7
@

Publishing Interval ltem Count q No

rosoft Windows [Version 10.0.19045.3930]
Microsoft Corporation. All rights reserved.

Users\hansha>cd /

\>cd C:\Temp\Python

=\

/

OPC
Pre
29
23
20
29
30
27

\Temp\Python>python opcua_write.py

ptography is not installed, use of crypto disabled
tography is not installed, use of crypto disabled
UA Client Connected

ss Ctrl-C to Stop Program

OPC UA Client Write Example

Comma

- t ThisPC > 0OS(C:) > Temp > Python g Search Pytho

@ OneDrive e Name Date mo

DAQ and |0 Medules in LabVIEW

i}

= opcua_read.py 2024-02-08 13:43 Pytho

i}

Examples
LabVIEW OPC UA

opcua_server.py 2024-02-08 14:20 Pytho

i}

= opcua_write.py 2024-02-08 13:49 Pytho
UaExpert OPC UA Client

Creative Cloud Files Personal Account ha

@ OneDrive - Personal

2 This PC
# 3D Objects
I Desktop

3 items

Running Multiple instances of
the Command Prompt

pt - python opcua_read.py

Microsoft Windows [Version 10.0.19645.3930]
(c) Microsoft Corporation. All rights reserved.

\hansha>cd /

\Temp\Python

C:\Temp\Python>python opcua_read.py

cryptography is not installed, use of crypto disabled
cryptography is not installed, use of crypto disabled
OPC UA Client Connected

Press Ctrl-C to Stop Program

29.0
PEN
20.
29.
30.
27.

OPC UA Client Read Example




Multiple Spyder Editors

\Users\hansha

Interfac

Language: English

Rendering engine: | Software

History

.
AR [¥) Show internal Spyder errors to report them to Github YO u Ca n a ISO r u n M u Itl p I e

Profiler
[J Check for updates on startup

instances of the Spyder Editor

Run

Keyboard short

Status bar

Variable explorer

Current working directory
Editor

IPython console

Reset to defaults Cancel Apply

IPython console History
# Kite: indexing <> LSP Python: ready @ conda: base (Python 3.9.7) Line1,Coll ASCO CRLF RW Mem49%




File ~ Settings ~ Help ~
Endpoints URLs opc tcp://xps15hph:62640/IntegrationObjects/ServerSimulator
Sessions
Last Contact

15:08:51
15:08:57

Sessionld Name

Pure Python

C:\Temp\Python\opcua_write.py

o opcua_write.py X

from opcua 1 Client
1 t time

#0PC Server Simulator from Integration Objects

url = "obé.tcp://lo(alhost:éz&d@/lhtegramonob]ects/ServerSlmulat
nodeId = "ns=2;s=Tag7"

client = Client(url)

client.connect()

print("0PC UA Client Connected")
print("Press Ctrl-C to Stop Program")

t
ile True:
value = random.randint(20,30)
print(value)

node = client.get_node(nodeId)
value = float(value)
node.set_data_value(value)
time.sleep(10)

except KeyboardInterrupt:

client.disconnect()
print("0PC UA Client Disconnected and Progam Stopped")

OPC UA Client Write Example

C:\Temp\Python\opcua_read.py

OPC UA Client Read Example
o e

Source | Console Object

opcua_read.py X

from opcua 1impo
t time

t Client

//1ocalhost: 6264
rs=Tag7"

w0 \Users\hansha l o

Object

tri-C to Stop Program")

Source | Console

Usage L
/
Here you can get help of L
any object by pressing
Ctri+1in front of it, either ‘
on the Editor or the
Console.

>
Help can also be shown
automafically after
wrifing a left parenthesis
nextto an object. You
can activate this

Help Variable Explorer Plots Files

(url)
)

lient Connected")

“client. get_node(nodeId)

node.get_value()
alue)
eep(10)

Interrupt:

ct()

“lient Disconnected and Progam Stopped")

Usage

Here you can get help of
any object by pressing
Ctri+lin front of if, either on
the Editor or the Console.

Help can also be shown
automatically after writing
a left parenthesis next o
an object. You can activate
this behavior in
Praforances > Holn

Help Variable Explorer Plots Files

(] [ ]

Console 1/A x

In [1]: runfile('C:/Temp/Python/
opcua_read.py', wdir='C:/Temp/Python"')
OPC UA Client Connected

Press Ctrl-C to Stop Program
24.

24.

29.

25.

28.

20.

29.

o L}

IPython console History

Console 1/A x

In [1]: runfile('cC:/Temp/Python/
opcua_write.py', wdir='C:/Temp/
Python')

OPC UA Client Connected

Press Ctrl-C to Stop Program

IPython console History

C I 2l lseesinin

) oo Wi Ll

Running Multiple instances
of the Spyder Editor




Multiple Thonny Editors

| General |Interpreter Editor Theme & Font Run & Debug Terminal Shell Assistant

| [ Allow only single Thonny instance

—=ogepregraTESageaveRs
[J Reopen all files from previous session
[ pisable notification sound

[] Debug mode (provides more detailed diagnostic logs)

Language IEnglish v I
Ul mode
Ul scaling factor 1.5 v

Font scaling mode |default v

Environment variables (one KEY=VALUE per line)

NB! Restart Thonny after changing these options!

Cancel

< Tools -> Options ...

You can also run Multiple
instances of the Thonny Editor




OPC UA Client Write Example J

=

B orC
[ OPC UA Client Read Example ]
Server Endpoints URLs opc.tcp://xps15hph:62640/IntegrationObjects/ServerSimulator m
[Sessions |
Sessionld Name User Last Contact T Tho e thon\o @ - [
Pure Python Client.. Anonymous ns=3i=1297734378 10:47:25 YF\‘E Edit View Run Tools Help
Pure Python Client.. Anonymous ns=3;i=1297734434 10:47:28
=7 O % @™
Ncua_read.py
= 1 from opcua import Client :
Subscriptionld Publishing Interval ltem Count Seq No 2 import time
3
4
5 url = "opc.tcp://localhost:62640/IntegrationObjects/ServerSinm
Status: Running ~ Cumrent Time: 10:47:33  Sessions: 2 hons: 0 ltems: 0 6 nodeld = "ns=2;s=Tag7"
7
T 8 client = Client(url)
File Edit View Run Tools Help o
Jﬁt 0 ’ or 9 client.connect()
opcus ey 10 print("OPC UA Client Connected")
[l £rom opcua import Client E print("Press Ctrl-C to Stop Program")
2 import time
. 13 try:
3 import random .
4 14 while True:
5 . 15 node = client.get_node(nodeId) .
6 url = "opc.tcp://localhost:62640/Integratio chel
7 nodeld = "ns=2;s=Tag7"
. o >>>
OPC UA Client Connected . . .
pess cinc e s meszn | Rynning Multiple instances
>>> o
OPC UA Client Connected Of the Thonny Edltor « Thonny's Python

Local Python 3 « Thonny's Python
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Python OPC UA Server

Normally, the OPC Server OPC UA Server
v (o

and the different OPC
X i
Clients runs on different Python Script

computers distributed in a — —
network

Python Script Python Script
| —— . —

OPC UA Write Client OPC UA Read Client



OPC UA Server

from opcua import Server This is the main Python code

for creating an OPC UA Server
server = Server ()

server url = "opc.tcp://127.0.0.1:1234"
server.set endpoint (server url)

name ="opcuapython"

namespace = server.register namespace (name)
node = server.get objects node ()

param = node.add object (namespace, "Sensors")

var = param.add variable (namespace, "Temperature",0)
var.set writable()

server.start ()



from opcua import Server
import time
from datetime import datetime

server = Server ()
server url = "opc.tcp://127.0.0.1:1234"
server.set_endpoint (server url)

name ="opcuapython"

namespace = server.register namespace (name)

node = server.get objects node()

param = node.add object (namespace, "Sensors")

var = param.add variable (namespace, "Temperature",0)

var.set writable ()

server.start ()
print ("OPC UA Server Started")
print ("Press Ctrl-C to Stop Program")

try:
while True:

now = datetime.now ()
current time = now.strftime ("%H:3M:%S")
print ("OPC UA Server Running", current time)
value = var.get value ()
print ("Current Value:", value)
time.sleep (1)

except KeyboardInterrupt:
pass

server.stop ()
print ("OPC UA Server Stopped")

OPC UA Server




Test Connection to Server

Bl Unified Automation UaExpert - The OPC Unified Architecture Client - NewProject™ - o X
File View Server Document Settings Help
X% & B X
Data Access View ©  Attributes 8 x
= Server Node Id Display Name Value Datatype  sourcd 2| @ [+)
1 Python OPC UA Server NS2|Numeric|2 Temperature 01:00: | Attribute A
D LabVIEW OPC UA Server v Nodeld
£ OPC UA Server Simulator Namespacelndex
123 Python OPC UA Server IdentifierType
v [3 Documents Identifier . . .
3 Data Access View NodeClass
Bcatare ient rrom integration JeCts
Address Space 8 x DisplayName
43 |No Highlight v Description
é 2 v Value
oot SourceTimestamp © . — 3
v © objeas . R | Integration Objects' OPC UA Client - = x
v & sen
:‘c :::penlure References & x| Home
3 .~ a O | W dhi, . ~
> & Sever + BQ.‘\‘\ 26 v %
> B Types Reference Terget DisplayN; -+ ) S NG o o || oo )
> & Views HasTypeDefiniti.. BaseDataVariabl)| New ~ Open Save Save | COmnect Discomnect e e 4 e Remove | Cerificate Manager
as
File Session Configuration Help Default Configuration Ceriificate
< > ;
< > | [sessions DataView | History View _Event View
8 X | [ "= Sessions Display ‘Nod ibute
e Data Source | Status - - Attril Value
@ Sessiond Name id Value Type Timestamp | Timestam Code Subsciption [ Session [, [IFSSR) N
Source Server Message 5 NodeClass Variable
DA Plugin QascDaModel:dropMimeData
DA Plugin Python OPC UA... No subscription available for Serverld 2
DA Plugin Python OPC UA... Creating n ion: Cli 1, LifeTimeCount=2400, =10, Priority=0, MaxNotific...
DA Plugin Python OPC U CreateSubscription succeeded [ret = Good]
DA Plugin Python OPC UA... Revised values: LifeTimeCount=2400, MaxKeepAliveCount=10, Priority=0, Publishinginterval=500, Subscriptionld=80
DA Plugin Python OPC UA... Created subscription for Serverld 2 WriteMask 0
DAPlugin Python OPC UA... Item QueueSize=1, D Re - "
UserWriteMask 0
DA Plugin Python OPC UA... CreateMonitoreditems succeeded [ret = Good] serfinelles
DA Plugin Python OPC UA... ltem succeeded : RevisedQu 112 [ret = Good] |Address Space | Value 0
DA Plugin Python OPC UA... Write to node'NS2|Numeric|2' succeeded [ret = Good] | [Forward = DataType Ty
\ 12 %] ValueRank Scalar
ArrayDimensions System.Ulnt32(]
. AccessLevel Readable | Writeable
atxpert lent ekt Radabel Wi
MinimumSamplinglnterval  Continuous
Historizing False




Get Nodeld

B2 Spyder (Python 3.9) - [} x

f rom Op Cua imp @) rt C l j_ en t File Edit Search Source Run Debug Consoles Projects Tools View Help

[ ] —} a =] > o o I > ~ v 1 » ™ m e+ | OPC UA Server

...eDrive\Documents\Python\Python Programming\Code Examples\OPC\opcua\Python OPC UA Server\get_nodes.py e (e e

# O P C UA S erver P yt h on O opcua_client_write_ex.py X  opcua_client_read_ex.py X | get_nodes.py X =

opcua t Client Usage

=" tcp://127.0.0.1:1234"
— 0l Yy o Here you can get help of
ur opcC.tCCp: .VU.VU.1¢ g 0.1:125 any objectby pressing
Ctri+lin front of it, either
on the Editor or the
c{lent = C'Llenzgur'l) Console
client.connect|
Help can also be shown
o o namespace = client.get_namespace_array() Erieme fcaltya ey g
client = Client (ur PP snenpace) ek
activate this behavior in
objects = client.get_objects_node() (G IEE RS

client.connect () prne (s eces) I i s i

nodes = objects.get_children() Console 1/A x
print(nodes)

client.disconnect()

namespace = client.get namespace array ()

er
. http://opcfoundation.org/UA/",
p rin t ( name Spa ce ) ‘urn: freeopcua:python:server®,
*opcuapython’]
i=85
[Node (NumericNodeId( 53)),
Node (NumericNodeId(n =1))1

In [40]:

objects = client.get objects node() TR EER oy
- - 4 Kite: ready < LSP Python: ready @ conda: base (Python 3.9.7) Line8, Col17 UTF-8 CRLF RW Mem42%
print (objects)

nodes = objects.get children()
print (nodes)

This gives:
Nodeld ="ns=2;i=2"

client.disconnect ()



OPC UA Client Write Example

from opcua import Client

#OPC UA Server Python
url = "opc.tcp://127.0.0.1:1234"

nodeId = "ns=2;i=2"

client = Client (url)
client.connect ()

node = client.get node (nodeId)

value = float (20)
node.set data value (value)

client.disconnect ()



Write - Alternative Solution

from opcua import Client

#OPC UA Server Python
url = "opc.tcp://127.0.0.1:1234"

client = Client (url)
client.connect ()

root = client.get root node()
nodeId = root.get child(["0:Objects", "2:Sensors", "2:Temperature"])
print ("NodeId:", nodeld)

node = client.get node (nodeld)
value = float (20)

node.set data value (value)

client.disconnect ()



OPC UA Client Read Example

from opcua import Client

#OPC UA Server Python
url = "opc.tcp://127.0.0.1:1234"

nodeId = "ns=2;i=2"

client = Client (url)
client.connect ()

node = client.get node (nodeld)
value = node.get value()

print (value)

client.disconnect ()



Read - Alternative Solution

from opcua import Client

#OPC UA Server Python
url = "opc.tcp://127.0.0.1:1234"

client = Client (url)
client.connect ()

root = client.get root node()
nodeId = root.get child(["0:Objects", "2:Sensors", "2:Temperature"])
print ("NodeId:", nodeld)

node = client.get node (nodeld)
value = node.get value ()
print ("Value[°C]:", value)

client.disconnect ()



Testing OPC Server and Clients

OPC UA Server

T Thonny - CAUsers\hansha\OneDrive\Documents\Python\Python Programming\Code Examples\OPC\opcua\Python OPC UA Server\opcua_server ¢
File Edit View Run Tool
DESHE O% [~
opcua_server_expy
from opcua import Server
import time
from datetime import datetime

server = Server()
server_url = "opc.tcp://127.0.0.1:12
server.set_endpoint(server_url)

name ="opcuapython”
namespace = server.register_namespace(name)
node = server.get_objects_node()

param = node.add_object(namespace, "Sensors")
var = param.add_variable(namespace, "Temperature",®)
var.set_writable()

server.start()
print("OPC UA Server Started")
print("Press Ctrl-C to Stop Program")

1 20.0
Running 13:
)

Running
: 20.0

File Edit Search Source Run Debug Consoles Projects Tools View Help

S

B & @2 2 » O G I, m» ~

...ents\Python\Python Programming\Code Examples\OPC\opcua\Python OPC UA Server\opcua_client_write_ex.py

o opcua_client_write_ex.py X  opcua_client_read_ex.py %

from opcua import Client
#0PC UA Server Python

4 url = "opc.tcp://127.0.0.1:1234"
nodeIld = "ns=2;i=2"

client = Client(url)
client.connect()

node = client.get_node(nodeId)
value = float(20)
node.set_data_value(value)

client.disconnect()

OPC UA Clients

# Kite: ready <> LSP Python: ready

v 97 3% m A sss  OPC UA Server

Source | Console Object

Usage

Here you can get help of
any object by pressing
Ctri+lin front of it, either on
the Editor or the Console.

Help can also be shown
automatically after writing a
left parenthesis next to an
object You can activate this
behavior in Preferences >
Help.

New to Spyder? Read our

Help Variable Explorer Plots Files

O Console 1/A % - L]
Programming/Loae EXampLes/UrL/opcuay
Python OPC UA Server/
opcua_client_read_ex.py', wdir='C:/
Users/hansha/0OneDrive/Documents/Python/
Python Prngrammlng/(ode Examples/OPC/
opcua/Python OPC UA Server')

20.0

In [28]: runfile('c:/Users/hansha/
OneDrive/Documents/Python/Python
Programming/Code Examples/OPC/opcua/
Python OPC UA Server/
opcua_client_write_ex.py', wdir='C:/
Users/hansha/OneDrive/Documents/Python/
Python Programming/Code Examples/OPC/
opcua/Python OPC UA Server')

In [29]:
IPython console History
@ conda: base (Python 3.9.7) Line4, Col 32 ASCI CRLF RW  Mem 42%
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Installation

e OPC UA Python Client GUI
* https://github.com/FreeOpcUa/opcua-client-gui



https://github.com/FreeOpcUa/opcua-client-gui

Installation using Thonny

T& Manage packages for C:\Users\hansha\AppData\Local\Programs\Thonny\python.exe

|0pcua-clienti | Search on PyPI
jedi ~ .
kiwisolver opcua-client
lazy-object-proxy
Ixml Installed version: 0.8.4
matplotlib Installed to: C:\Users\hansha\AppData\Roaming\Python\Python310\site-packages
mccabe
mypy Latest stable version: 0.8.4
mypy-extensions Summary: OPC-UA Client GUI
nidagmx Author: Olivier R-D
numpy Homepage: https://github.com/FreeOpcUa/opcua-client-gui
A PyPI page: https://pypi.org/project/opcua-client/

- Requires: PyQt5, asyncua, opcua-widgets (>=0.6.0)
upuua'vv;dycls

packaging

paho-mqtt

paramiko

parso

pillow

pip

platformdirs

pycparser

pylint
pymongo v Upgrade Uninstall Close




T& Manage packages for C:\Users\hansha\AppData\Local\Programs\Thonny\python.exe

pyqtgraph

<INSTALL> A

adafruit-board-toolkit
aiofiles
aiosqlite
astroid
asttokens
asyncua
berypt
bitstring

cffi

colorama
contourpy
cryptography
cycler
deprecation
dill
dnspython
docutils
ecdsa
esptool
fonttools
guizero

isort v

pyqtgraph

Latest stable version: 0.13.3

Summary: Scientific Graphics and GUI Library for Python
Author: Luke Campagnola

Homepage: http://www.pyqtgraph.org

PyPI page: https://pypi.org/project/pyqgtgraph/
Requires: numpy (>=1.20.0)

You may also need to instal

Install

Search on PyPI

III

Pyqtg

Close

raph”



Location of “opcua-client.exe”

| M =

Home Share

Scripts

« e

s# Quick access
I Desktop
¥ Downloads
@ OneDrive

guizero

View

Integration Objects Examples

LabVIEW OPC UA

opcua
@ Creative Cloud Files
@ OneDrive - Personal

= This PC

_J 3D Objects
I Desktop
| Documents
4 Downloads
b Music

& Pictures

B videos
20 items

> Hans-Petter Halvorsen 3

~

AppData > Roaming > Python > Python310 > Scripts

Name

‘A f2py.exe

v

v

)

opcua-client.exe
pyftmerge.exe
pyftsubset.exe
pylupdate5.exe

pyrcc3.exe
pyuic5.exe
thx.exe
uabrowse.exe
uacall.exe
uaclient.exe
uadiscover.exe
uageneratestructs.exe
uahistoryread.exe
uals.exe
uaread.exe
U3server.exe

uasubscribe.exe

PPPPPPIPIPPPPPPPOPPPE

uawrite.exe

~

Date modified

2023-02-15 15:01
2023-02-15 15:01
2023-11-29 11:30
2023-02-15 15:01
2023-02-15 15:01
2023-11-2911:30
2023-11-29 11:30
2023-11-29 11:30
2023-02-15 15:01
2023-11-2911:30
2023-11-2911:30
2023-11-2911:30
2023-11-29 11:30
2023-11-29 11:30
2023-11-2911:30
2023-11-2911:30
2023-11-2911:30
2023-11-29 11:30
2023-11-29 11:30
2023-11-29 11:30

v O

Type

Application
Application
Application
Application
Application
Application
Application
Application
Application
Application
Application
Application
Application
Application
Application
Application
Application
Application
Application
Application

Search Scripts

Size

106 KB
106 KB
106 KB
106 KB
106 KB
106 KB
106 KB
106 KB
106 KB
106 KB
106 KB
106 KB
106 KB
106 KB
106 KB
106 KB
106 KB
106 KB
106 KB
106 KB




OPC UA Python Client GUI

| opc.tcp://xps15hph:62640/IntegrationObjects/ServerSimulator ~ | |Connect options Connect Disconnect
Attributes =

DisplayName BrowseName Nodeld =
> B Tagii 0:Tag1 ns=2;5=1:Tag11 Attribute Value DataType ~
> § Tagl12 0:Tagl12 ns=2;s=1:Tag12 AccessLevel CurrentRead, ... Byte
> § Tag13 0:Tag13 ns=2;s=1:Tag13 ArrayDimensio None Null
> g Tagl4 0:Tag14 ns=2;s=1:Tag14 BrowseName 0:Tag7 QualifiedName
> § Tagl15 0:Tag15 ns=2;s=1:Tag15 DataT_yp_e Double Nodeld
> B Tegls 0:Tag16 ns=2;s=1:Tag16 Description  None Null

” DisplayName LocalizedText(Locz LocalizedText
> g Tag17 0:Tag17 ns=2;5=1:Tag17 Historizing True Boolean
> g Tagl8 0:Tag18 ns=2;s=1:Tag18 MinimumSam; -1.0 Double
> B Tag19 0:Tag19 ns=2;s=1:Tag19 NodeClass 2 Int32 2
> § Tag2 0:Tag2 ns=2;s=1:Tag2 Refresh
> § Tag20 0:Tag20 ns=2;s=1:Tag20
> § Tag3 0:Tag3 ns=2;s=1:Tag3 Graph 5 X
> g Tag4 0:Tag4 ns=2;s=1:Tag4 _
> B Tags 0:Tag5 ns=2;s=1:Tag5 Number of Points Intervall [s] ‘:] Apply
> % Tagb 0:Tagb ns=2;s=1:Tagb
> B Tag? 0:Tag7 ns=2s=1:Tag7 0.8
> g Tag8 0:Tag8 ns=2;s=1:Tag8 0.6
> g Tag9 0:Tag9 ns=2;s=1:Tag9 0.4
> @ Methods 2:MethodCalls ns=2;s=MethodCalls 0.2
> [ Real Time Data 2:Realtimedata ns=2;s=Realtimedata
> IR Types 0:Types i=86 0.1 0.2 0.3 0.4 0.5 0.6 0.7 0.8 0.9
> Il Views 0:Views i=87 v -
Events Subscriptions References Graph

uaclient.uaclient - INFO - Connecting to opc.tcp://xps15hph:62640/IntegrationObjects/ServerSimulator with parameters None, None, None, None')
asyncua.client.client - WARNING - Deprecated since spec 1.04, call load_data_type_definitions")
asyncua.client.client - WARNING - Deprecated since spec 1.04, call load_data_type_definitions")
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